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ABSTRACT 

 

 

Modern technology largely depends on automation and control systems. Automation and 

control system refers to the use of various control systems for operating equipment such as 

machinery, processes in factories, boilers, heat treating ovens, switching on telephone 

networks, steering, and stabilization of ships, aircraft, automobiles, and other applications with 

minimal or reduced human intervention. The greatest advantage of automation and control 

system is that it saves labor. A water level indicator system is a device that indicates the level 

of water in a tank or reservoir. It is widely used in industrial applications such as boilers in 

nuclear power plants and residential applications. The project is to design a water level 

indicator with an automatic water pump controlling system. The water level sensor has been 

made to apprehend the water level properly. The microcontroller is responsible for precisely 

controlling the overall system, which reduces control complexity. It takes input through the 

sensor unit that senses the water level. After taking input, output intends the pump's action 

(on/off) with respect to the current water status of the tank. An Android app display unit 

indicates the pump's status and water level via IoT. Pump control will be possible from remote 

locations using the internet. 
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CHAPTER  1 

INTRODUCTION 

 

1.1  INTRODUCTION 

 

In recent years, water has gained incalculable value. The diverse faces are the main reason for 

this circumstance. Water’s various issues have been forerunners of population growth, aging 

infrastructure, obsolete technology, and groundwater contamination. These difficulties have 

pushed drinking water to the point where it is now considered a luxury rather than a need. This 

problem of scarce drinking water necessitates a strategy that is both feasible and effective. The 

overhead tank and quality monitor system is one such method. The practice of describing or 

quantifying the amounts of water available for, or consumed by, one or more "consumptive 

uses" is known as water allocation. This refers to volumes of water utilized in the contributing 

catchment, used from the lake or reservoir itself, or discharged from the lake or reservoir for 

downstream use in this lake management context. Irrigation, industrial applications, and home 

water supply are examples of consumptive uses, which include the removal of water from a 

river, lake, or reservoir. If a Brief evaluated the absolute or relative volumes of water utilized, 

or projected to be used, in any of these enterprises, it was seen to be dealing with the matter of 

water allocation. 

During water pumping from the underground storage tank to the feed water tank, there is 

always water overflow that leads to water wastage. Secondly, as water circulates from the 

overhead storage tank to indoor utility points, there is a challenge of determining the remaining 

volume of water in the tank, and this could result in an unscheduled stoppage of economic or 

domestic activities. Also, ascertaining the water quality to be supplied in the industry or power 

station for delicate use is of concern, especially when the feed water and demi water tank are 

not easily accessible. This work seeks to address these specific problems. 

 

Recently, IoT has gained tremendous attention in the industry ranging from simple auto 

automation-based applications to sophisticated applications. The standard setting of water 

storage and circulation system in homes and industries consists of overhead storage, pipeline 

network, and underground storage tanks. In monitoring an overhead tank set-up, remote 

monitoring and data collection systems are necessary to collect information from the tank based  
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on the pre-set values and communicate processed information to the user when necessary or to  

make decisions in a dire situation. IoT trend has opened up research areas, including 

investigating the systematic evaluation of water features by articulating its based sensor 

networks.  

We have designed a real-time wireless monitoring system for tank water levels based on IoT 

and supported an alarming subsystem. An IoT system for monitoring several waters and 

pollutant parameters was implemented. We monitored the 5 levels of water. The parametric 

water and wireless network were configured for accessible signal data collection and 

assessment. A real-time water level monitoring system was designed and implemented. An 

ultrasonic sensor was used to detect the desired parameter. If the water level reaches the pre-

set parametric value, the signal will be fed in real-time to mobile. A pre-set percentage range 

of the sensors was used to manipulate the pump's operation through the regulating valves. In 

this work, a configured monitoring system was discussed based on the ESP-8266 

microcontroller to replace the level stick sensor used in beverage industries to monitor the 

water level in the feed water tank and storage tank. Depending on the sensor reading, the 

Arduino IDE program sends the data to ESP-8266 and through the nodeMCU board, the pump 

is switched ON if only the water level in the upper tank is low. Also, the pump is switched OFF 

if the water level is filled in the upper tank. Depending on the sensor reading, the Arduino IDE 

program sends the data to ESP-8266 and through the nodeMCU board, the pump is switched 

ON if only the water level in the feed water tank is low. Also, the pump is switched OFF if the 

water level is filled in the feed water tank. 

 

1.2  OBJECTIVES OF THE STUDY  

 To indicate the water level of the feed water tank and storage tank. 

 To measure the water level by using an ultrasonic sensor. 

 To develop android apps for monitoring the system.  

 To implement the smart pump controller including manual control facility using 

IoT. 
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CHAPTER  2 

LITERATURE REVIEW 

 

2.1 BACKGROUND 

 

Before beginning a new investigation, a literature review builds familiarity with and 

comprehension of current research on a certain topic. Conducting a literature study should 

allow us to learn about previous research and determine what is unknown about our topic. In 

this project, a literature review of Smart Pump Controllers Including Manual Control Facility 

Using IoT in every industry at the demi water tank and reserve tank for the boiler. Water Level 

Monitoring can be found in many areas since before. Various types of Water Level Monitoring 

systems based on the control are:  

Individual systems: This is a very popular type of system. Here the whole model is 

implemented on a targeted single source system. Large control systems: Here the water level 

is implemented on a very large scale basis and huge amounts of sensors are used. 

Central Control systems: Computerized systems programmed to handle all the functions of 

multiple utilities like air conditioning systems or home entertainment systems, and refrigerators 

all at the same instant regardless of our presence. Control systems can be accessed through 

telephone or internet from any corner of the world. 

 

2.2 PREVIOUS STUDIES 
 

Here is some review on Smart Electricity Theft Detection and Power Consumption Monitoring 

System. Discussion is going to review those papers. 

 

In this paper, Priya J and Sailusha Chekuri proposed that IoT based Water Level Monitoring 

System is an innovative system that will inform the users about the level of liquid and will 

prevent it from overflowing [1]. To demonstrate this the system makes use of containers, where 

the ultrasonic sensors are placed over the containers to detect the liquid level and compare it  
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with the container’s depth. The system makes use of an AVR family microcontroller, 

Raspberry Pi, LCD screen, Wi-Fi modem for sending data, and a buzzer. 

In this paper, Timothy Malche and Priti Maheshwary develop this project which is based on a 

water level monitoring system. Water source is necessary and an important factor in 

agricultural and farm production and is a key to our quality of life as well [3]. The monitoring 

water level of a water source, such as a water tank or bore well, etc., plays a key role in 

agriculture. For example, if a water level drops below the threshold level for pumping in a bore 

well, the pump motor may get damaged due to dry running. This paper proposes a prototype 

system design, implementation, and description of required tools and technologies to develop 

an Internet of Things (IoT) based water level monitoring system which can be implemented in 

future smart villages in India. 

 

This research provides a reliable system for monitoring water levels and quality in overhead 

tanks in order to reduce current water waste and improve water quality. The project is about an 

overhead tank monitoring system, in which they monitor the amount of water in the above tank 

and also determine the type of water. They may choose how much water is required for a certain 

region based on the water level and provide a suitable amount of water rather than wasting 

water. Finally, information will be compiled, and it will be viewable on a variety of devices 

via an Android app via Wi-Fi. Workers will be dispatched to clean the tank based on the 

information in the app. 

 

In this paper, they discuss the idea of managing and monitoring lake levels as a village water 

storage source. More specifically, they described how to use a raspberry pi as a controller for 

wired and wireless water level detection and control. The use of a water level management 

strategy would aid in minimizing the amount of time needed for water allocation, the need for 

water during the summer, drought conditions, and water waste. Additionally, it can show how 

much water is there in the lake to support various Global Water kinds, such as cellular data 

loggers and GSM through data transmission systems for office water management. 

Furthermore, recently, cellular phones with comparatively powerful computing capabilities 

and excellent graphical user interfaces have become available. 

 

In this paper, Mutinda Mutava Gabriel and Kamweru Paul Kuria developed this system. Motion 

detection has become one of the great areas of research in the world. Many activities are carried 

out in the presence of motion. One of the research focus has been the use of Arduino Uno  

4 



microcontroller, Ultrasonic sensor, passive infrared sensor, and many others to sense and 

measure distances. This study aimed at designing a sensor that can easily measure how far the 

object is, monitor changes in distances as the object approach, and display the results in the 

Liquid Crystal Display (LCD), giving a light-coded signal and a sound alarm. The hardware 

utilized included the Arduino Uno on breadboard interfaced with LCD, LEDs, Buzzer, and 

Ultrasonic sensor. The study demonstrated that the designed sensor could be used to accurately 

determine the position of an approaching object and display the distance readings on the LCD. 

 

This paper describes to lay out and build a manually controlled surveillance system. Ultrasonic 

sensors are first-rate gear to degree distance without real touch and used at several places like 

water degree measurement, distance dimension, etc. this is an efficient manner to measure 

small distances exactly. In this assignment, we've got used an Ultrasonic Sensor to determine 

the space of an obstacle from the sensor. The simple principle of ultrasonic distance 

measurement is primarily based on ECHO. The module works on the natural phenomenon of 

the ECHO of sound. A pulse is dispatched for about 10us to cause the module. Ultrasonic 

sensor HC-SR04 is used right here to measure distance in a variety of 2cm-400cm with an 

accuracy of 3mm. 

 

2.3 PROBLEM STATEMENT OF THE STUDY 

 

 They did not use any securer’s database system. 

 The pump will be turned on depending on the water level in the storage tank, otherwise 

priming in the pump will be difficult. 

 When there is water in the storage tank, the pump will start. That is why we need to 

develop a sensor-based monitoring system. 

 We need a strong data connection for the micro-controller to develop IoT based 

monitoring system.  
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CHAPTER  3 

DESIGN AND WORKING PRINCIPLE 

 

3.1 DESIGN OF A PUMP MONITORING SYSTEM  

Hardware refers to the equipment or modules in the context of technology. A sensor is a device, 

module, or subsystem that detects events or changes in its surroundings and sends the 

information to other electronics, usually a computer processor. We have used lots of hardware 

and software components in our project. Now let’s discuss those components below. 

 NodeMCU 

 Ultrasonic Sensor 

 LCD Display 

 I2C Module 

 Relay Module 

 Pump 

 

3.1.1 NodeMCU 

NodeMCU is an open-source Lua-based firmware and development board specially targeted for 

IoT-based Applications. It includes firmware that runs on the ESP-8266 Wi-Fi SoC from 

Espressif Systems, and hardware that is based on the ESP-12 module. 

Fig 3.1: NodeMCU Pinout 
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NodeMCU Specifications: 

 Microcontroller: Tensilica 32-bit RISC CPU Xtensa LX106 

 Operating Voltage: 3.3V 

 Input Voltage: 7-12V 

 Digital I/O Pins (DIO): 16 

 Analog Input Pins (ADC): 1 

 Flash Memory: 4 MB 

 Clock Speed: 80 MHz 

 

Working Principle: NodeMCU is the microcontroller of this project. It has some digital pins, 

one Rx Tx pin, one analog pin, etc. This pin is also used to control input and output devices. For 

the analog input signal, we have only used the A0 pin. For the digital input signal, we have used 

D5-D8 pins. These pins are also used as digital input/output. Here, the positive point of the power 

supply connects with the Vin pin and the negative point connects with the GND pin. All the input 

and output devices connect between D5 to D8. For the input signal, we have declared this pin as 

input and for the output signal, we have also declared this as output. We have used three 

NodeMCU for this project. 

 

Fig 3.2: NodeMCU placed in the project 
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3.1.2 Ultrasonic Sensor 

The Ultrasonic HC-SR04 Sensor Module is a widely used sensor for measuring distance and 

detecting objects in a variety of applications. It is shown in figure 5. It works in the same way 

that a radar system does. Ultrasonic sensors operate by producing high-frequency sound waves 

those humans can’t hear. The transmitter emits a high-frequency sound pulse, which is received 

by the receiver when it reflects back from any object’s surface.  

The sensors detect objects in this manner. It can detect objects or measure distances between 

2cm and 400cm. The ultrasonic sensor works in the same way that a bat's object detecting 

system does. We can also claim that it works in the same way that a radar system does. The 

Transmitter (TX) and Receiver (RX) are the two primary components of the ultrasonic or HC-

SR04 module (RX) [17].  

 

Fig 3.3: Distance measured by using ultrasonic sound 

Working Principle:  

Echo and Trig pin of the ultrasonic sensor at storage tank connected with D5 and D6 pin of 

NodeMCU. Again Echo and Trig pin of the ultrasonic sensor at the feed water tank connected 

with the D7 and D8 pin of NodeMCU. The trig pin emits ultrasonic sound, which is received 

by the echo pin. To make the ultrasonic sound, we must first set the Trig pin to a High State 

for 10 seconds (microseconds). Where the distance between the sensor and the object is denoted 

by s. The sound speed in air is v = 0.034cm/s or 340 m/s. The time it takes for sound waves to 

bounce back from an object's surface is called t. Because time will be doubled when the waves 

travel and bounce back from the originating point, we must divide the distance value by two 

Power Supply − +5V DC. 
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Operating Condition:  

 Quiescent Current:  <2mA 

 Working Current: 15mA 

 Effectual Angle: <15° 

 Ranging Distance: 2cm – 400 cm/1″ – 13ft 

 Resolution: 0.3 cm 

 

 

Fig 3.4: Ultrasonic sensor placed in the tank 

 

 

3.1.3 LCD Display:  

With the use of a common overhead projector, the liquid crystal display (LCD) panel is  

Fig 3.5: LCD Display 

 

9 



designed to project on-screen information from a nodeMCU onto a screen so that condition of 

the grid could be shown on display. LCD (Liquid Crystal Display) is a type of flat panel display 

that operates primarily with liquid crystals. LEDs are widely used in cellphones, televisions, 

computer monitors, and instrument panels, and they have a wide range of applications for 

consumers and enterprises. Two sizes of LCD display have been used for this 

 the project which was 16x2 and 20x4.  

 

Working Principle: 

The power unit supplies power ultrasonic sensors, I2C module, nodeMCU, and relay module. 

It activates all the components and other equipment which are used in this water level indicating 

the project. LCD displays were used to show the output on the display. LCD display connected 

with I2C module. Before using its needs to initialize the display by coding. In a 16x2 display, 

we can write 16 characters at a time in one line and only two rows were used. Output result 

was shown on the LCD display. The level of water and operation of the pump was shown on 

the LCD display.  

 

3.1.4 I2C Module 

I2C is a single-ended, synchronous, multi-slave, multi-master packet switched serial bus. 

Multiple chips can be connected to the same bus, for example. Serial Data Line (SDA) and 

Serial Clock Line (SCL), both bidirectional open collector and open drain lines, are pulled up 

with resistors in I2C. I2C module needed only two pin uses. It is the main benefit of I2C 

display. Because LCD needed more than 7 or 8 pins of Arduino. It reduced the pin use of 

Arduino. 

Specifications: 

 Screen Resolution: 128*64 Pixels 

 Screen Active Area: 47.1*26.5mm 

 Individual Pixel Size: 0.33*0.33mm 

 Communication Mode: I2C(100Kbit/s and 400Kbit/s) 

 Operating Frequency 16 MHz 
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Fig 3.7: I2C Module 

Working Principle: 

 

The LCD display used a number of 5 pins of Arduino to control the module. 16x2 LCD display 

was used for this project. I2C module was attached with an LCD display for control. 

Controlling LCD was easier after using the  I2C module. 5v power was supplied in I2C to 

activate the module. SDL and SCL pins were connected with nodeMCU D1 and D2 pins. LCD 

showed monitoring data of this project. 

 

Fig 3.8: LCD and I2C placed in the project 
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3.1.5 Relay Module 

 

An electromagnet operates a power relay module, which is an electric switching device. The 

microcontroller sent a low signal in the relay module. The electromagnet pulls to open and 

close an electrical circuit when energized. Relays control one electrical circuit by opening and 

closing contacts in another circuit. As relay diagrams show, when a relay contact is normally 

open (NO), there is an open contact when the relay is not energized. The relay module had two 

parts. One part was connected with the controlling part. Another part is connected with the 

output load. When a relay contact is normally open (NO), there is an open contact when the 

relay is not activated, as shown in relay schematics. 

Specifications: 

 Voltage Input: 3.75V – 6V. 

 Active current: ~70mA. 

 Operative Voltage:  250VAC/30VDC. 

 Maximum current: 10Amp. 

 Operating time: 10msec 

 Release time: 5msec 

 

Fig 3.9: Relay Module Setup in the project 
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3.1.6 Pump 

This is a brushless submersible pump that can work at 3.5V to 9V voltage, with low noise, and 

low power consumption. This is a brushless submersible pump with a USB connector, that can 

work at 3.5V to 9V voltage, low noise, and low power consumption. It can be easily integrated 

into our safety security system project. The water pump works using the water suction method 

which drains the water through its inlet and released it through the outlet.  

 

Fig 3.10: Submersible water pump 

 Specifications: 

 Operating Voltage (VDC): 2.5 to 6 

 Operating Current (mA): 130 to 220 

 Flow Rate (L/H): 80 to 120 

 Material: Plastic 

 Inner Diameter (ID): 5 mm 

 Outer Diameter (OD): 7.5 mm 

 

Working Principle:  

The water level in the tank was bottom in the tank. This pump was placed in the storage tank. 

At first, this pump connected with a relay module. This module controls the pump by changing 

the HIGH and LOW signals.  
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3.2 SOFTWARE DEVELOPMENT 

 

Software development is another important topic for this project. This was a water level 

indicating process so some programming or coding develop to control the microcontroller.  For 

project purposes, Arduino is used as a microcontroller. Then Arduino IDE was used to control 

the Arduino controller. By doing this step, electricity theft was detected smartly. 

3.2.1 Arduino IDE 

 

Arduino is an open-source electronics platform that uses simple hardware and software to make 

it easy to use. Arduino boards can take inputs - such as light from a sensor, or a finger on a 

switch and convert them to outputs - such as turning on an LED, triggering a motor, or 

publishing anything online.  

 

Fig 3.11: Arduino IDE Software 

The Arduino IDE employs C++, however, because the physical environment is constrained, 

not all C/C++ features are available. The Arduino environment includes auxiliary functions to 

make using the hardware easier, as well as a serial monitor for input and output. When the 

board is connected, this will display the serial information of our Arduino. Board and Serial 

Port tell us what board is being used and what serial port it’s connected to. 
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3.2.3 Arduino Variable Declaration and Library Included  

 

Fig 3.12: Library included and firebase authentication 

We will see Arduino IDE screen the header file #include <wire> and #include 

<Liquidcrystal_I2C.h> are the Ultrasonic sonar sensor and LCD Display library for Arduino 

IDE. Here we declared distance in float and declared a variable f then trig Pin = 3 and echo Pin 

= 2 are declared in there. Liquidcrystal_I2C LCD (0*27, 16, and 2) also declared. Sub function 

is declared. Pin Mode (trig Pin, OUTPUT); pin Mode (echo Pin, INPUT); LCD. 

Backlight (); LCD. Into (); are declared here. The Declare and setup function is shown in the 

figure. 

In this, some variables were declared as an integer type and float type variables.  Echo and trig 

pin were declared as integer type variables. So they showed the only number in the serial 

monitor. trigpinR and echopinR were declared as D5 and D6. Again TrigpinF and echopinF 

were declared as D8 and D7 pins. The pump was also declared as a D0 pin. percent and percent 

are set as float-type variables. The Getting sub-function was used to get data in the loop.  
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3.2.4 Void Setup Function  

In this project, a relay module was used to send the on-off signal to the Pump. In the nodeMCU 

screen, it was seen this project Relay module Pin was declared microcontroller 2&3 pin. The 

void loop checks the condition when pin1 is high the relay gives a signal to the Pump. When 

the signal was low the pump is off. Now, the Relay module code is shown in the figure. 

 

Fig 3.13: Pin mode Setup 

In this portion, all the variables are declared globally and pins are also declared which are used. 

In the setup function, microcontroller pins are to be identified separately. At first serial. begin 

function was declared. Pump declared as OUTPUT. echopinF and echopinR were declared as 

INPUT to receive the ultrasonic frequency. trigpinF and trigpinR were declared as OUTPUT 

to create the ultrasonic frequency. If any pin is called INPUT that means it took data for 

Arduino IDE. If the pin is declared as an OUTPUT, it will operate a load. For initializing the 

lcd1. init() sub-function was called. The backlight was turned on using backlight() sub-

functions. Serial begin was used to check the serial monitor.  
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Fig 3.14: Program for Firebase setup 

Host and author names were set in this code. At a time firebase was added to this setup function.  

In this portion, firebase is initialized here. FIREBASE_HOST is represented the URL of the 

firebase and FIREBASE_AUST has represented the password of the database. It gives the 

security of our database. 

 

3.2.5 Void Loop Function 

Loop body initialized loop function. The ultrasonic sensor is very effective to measure distance 

point by point. We see this picture sensor distance measurement process. In this loop function, 

trigpin was LOW for 2 microseconds and then it was HIGH for 10 microseconds. The echo pin 

was HIGH for receiving the signal. This value is calculated and converted as the distance which 

is put in the distanceR and distanceF variables. Here measurement is measured on the basis of 

a centimeter scale. Sonar sensor input signal send the microcontroller, microcontroller shows 

the data the display value by shown LCD display. When the condition is done microcontroller 

gives the signal to the relay.   
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Fig 3.15: Distance measuring code 

 

 

 

 

 

 

 

3.2.6 Compiling and Uploading System of Arduino 

Next, we need to click on the verify button (check mark) that’s located in the top left of the 

IDE box. This will compile the sketch and look for errors. Once it says “Done Compiling” 

we are ready to upload it. Click the upload button (forward arrow) to send the program to 

the Arduino board. 

Fig: 3.16: Compile and Uploading Code in Controller 

The relevant things must be picked from the Tools > Board and Tools > Port menus before 

uploading our drawing. The boards are discussed in the following sections. It's most likely 

COM1 or COM2 (for a serial board) or COM4, COM5, COM7, or above (for a USB board) on 

Windows; to find out, check for USB serial devices in the Windows Device Manager's ports 

area. Press the upload button in the toolbar or pick the Upload item from the Sketch menu once 

we have selected the right serial port and board. As the sketch is uploaded, the RX and TX 

LEDs on most boards will blink. When the upload is complete, the Arduino Software (IDE) 

will display a message or an error. When we upload a sketch, we are utilizing the Arduino boot  
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loader, which is a little software put onto our board's microcontroller. It enables us to upload 

code without the need for any further hardware. When the board resets, the boot loader is active 

for a few seconds before starting whichever sketch was most recently uploaded to the 

microcontroller. When the boot loader  

 

3.3 Database Management 

 

A database is an organized collection of structured information, or data, typically stored 

electronically in a computer system. The database is developed for storing signals from the 

sensors. Because it stores globally. At this time firebase is used for the database system. 

Firebase is a platform developed by Google for creating mobile and web applications. This is 

the flow chart for creating a project in Firebase 

 

3.3.1 Configure Database 

After configuring this database. We configured our database as a default account for firebase.  

 

Fig 3.17: Dashboard of Database 

 

Then this dashboard was opened. Different types of database options are shown on this 

board. 
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3.3.2 Realtime Database 

 

Fig 3.18: Realtime Database Selection 

A real-time database is selected for monitoring real-time data. It is selected from the left side 

dashboard. 

 

3.3.3 Database URL and Authentication Code 

 

Fig 3.19: Database URL 

 

Database URL and database authentication code were shown here. Firebase initialized in 

Arduino with help of this URL and code. Through this URL microcontroller connected with a 

particular database and transferred data to the firebase. 
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Fig 3.20: Database Authentication Code 

3.3.4 Data Communication 

 

Fig 3.21: Data Communication System 

Real-time data communication system was developed here. This data comes into the firebase 

as an integer. But it also comes as a string and character. This system was built with tag, sub-

tag, and value. Mood, percent, and pump were represented as tags, and slots were represented 

as sub-tag. These are found as a string. But the value was one kind of signal which came from 

the sensor via a controller. When the demi water tank was filled up with water, the water level  
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changed. This percentage was sent to the database via nodeMCU. Initially, this percentage was 

zero. It was changed with a respective input value of the sensor. At a time, the pump and other 

conditions sent a signal to monitor the data. This database was connected with android apps. 

 

3.4 APP DEVELOPMENT 

 

We develop an app for monitoring this project. It is an android app. It is a user-friendly app. 

This app is built with help of the MIT app inventor platform. It is an intuitive, visual 

programming environment that allows everyone to build fully functional apps for Android 

phones, iPhones, and Android/iOS tablets. Blocks-based coding programs inspire intellectual 

and creative empowerment. In this app, the percentage of water for both tanks were shown 

here. 

This is the mobile view of the front page. The developer and team members were included 

there. Also, attached is our supervisor’s name and her image. Go to Dashboard indicates to go 

to the next page of this app. If we pressed this dashboard, then we would shift to the monitoring 

page. This app has been connected to a database This was blocking the programming of 

monitoring. Get Value was used to get data from the database. The tag was used to mention 

the percentage of water level in a storage tank and a demi water tank.  

At first, data was collected from the feed water tank, and the percentage of water was shown  

on the display. Then collected data from the reservoir tank. This percentage is also shown in 

apps. At a time, pump status also showed in the app. The method of the monitoring system was 

changed by pressing automatic and manual modes.  
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CHAPTER  4 

Methodology 

4.1 INTRODUCTION 

The methodology is a broad research approach that describes how the research will be carried 

out and, among other things, the methodologies that will be used. These techniques are detailed 

in the methodology.  

Even while great emphasis is paid to the nature and types of processes to be followed in a 

particular operation or to achieve a target, the methodology does not define specific procedures. 

Such processes, when appropriate to a methodology study, form a constructive generic 

framework that can be broken down into sub-processes, amalgamated, or their sequence 

adjusted. We develop our smart theft detection project following this methodology step by step. 

 

4.2 FLOW DIAGRAM OF WATER LEVEL INDICATOR  

 

Fig 4.1: Flow Diagram of Project 
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System design is the process of defining the components, modules, interfaces, and data for a 

system to satisfy specified requirements. System development is the process of creating or 

altering systems, along with the processes, practices, models, and methodologies used to 

develop them. We have designed a system using NodeMCU, Ultrasonic sensors, a Submersible 

pump, switch, relay module, I2C module, and power supply. The hardware connection was 

built by wire. Ultrasonic sensors were placed on the reserved feed tank for measuring the water 

level. Output results and operation  

The system was shown on the LCD Display. All the modules and sensors were connected with 

a power unit to activate. The controller was connected with a Wi-Fi router or mobile data for 

transferring data into a database. This database was connected with mobile apps. These apps 

read all data and signals from the database. Finally, results showed in mobile apps and LCD 

displays.  

4.3 CONTRUCTED MODEL  

 

Fig 4.2: Design Model 
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To fix those issues patches are released. A resistor was implemented to fix this bug. We 

check any bugs in the code and fixed this issue immediately. First, the sensor measured the 

water level of the reserve tank using ultrasonic sound. Similarly, it was checked the water 

level in the feed water tank. If the feed water level was not correct, it would send a signal to 

the controller to start the pump. Before turning on the pump, the level of the reserve tank was 

also checked. If there were water in the tank then the pump would start and the feed water 

tank would fill up at the same time.  

Algorithm of Water: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig 4.3: Flow Chart of this Project There are some  issues that come up in the Algorithm of Water 
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CHAPTER  5 

RESULTS AND DISCUSSION 

 

5.1 INDEX 

 

The signal processing by the microcontroller required some time. All of this information is 

accessed via the internet. As a result, processing time was determined by the speed of the 

Internet. The value of the ultrasonic sensor was the main factor for this project. This value 

collect via controller and calculated this value automatically by using Arduino IDE software.  

This system took 3 to 5 seconds for the Wi-Fi module to cross the high-speed internet zone or 

connect with high bandwidth. Otherwise, it took between 5 and 12 seconds. Due to a weak 

connection, the controller will occasionally disconnect from our database 

 

5.2 RESULT 

At first, the system was connected with Wi-Fi or mobile data. Then it was automatically 

connected with firebase. If it was connected successfully, then the IP address was also shown 

on the LCD. Otherwise, nodeMCU was searching this IP address for connecting.  

Fig 5.1: Manual operating system 
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In this figure, the percentage of the feed water tank was 38% and the percentage of the reservoir 

was 84%. Pump status was stand by. 1 represented the manual mood of this system. A condition 

was developed for this system. If the percentage of the feed water tank was  

higher than 20%, then the condition of the pump would be ready to stand by. Again the 

percentage of the feed water tank was less than 20%, then the condition of the pump would 

run. If the percentage was above 80%, the pump was automatically off.  

 

 

 

 

 

 

 

Fig 5.2: Pump running status is shown on the display 

 

 

 

 

 

 

 

Fig 5.3: System running automatically 

Zero (0) represented that this system was running automatically. The pump was turned on or 

off automatically concerning the condition. This mood was changed from the mobile apps. 

Mood changing feature was included in the mobile apps. 
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5.3 Data Analysis 

The water tank was filled with time. The time required for filling the tank is around 3 minutes. 

The average time was calculated for this data table. Water filled up 188 cm3 for each 20 sec. 

The total volume of the water was 1675.3 cm3. It took time 0 to 177 sec. This time was changed 

with respect to the mass flow rate of the pump. 
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Fig 5.4: System running with android apps 

5.4 DISCUSSIONS  

This IoT-based proposed system is used to acquire water level details of a water source in real-

time from any location, any device connected to the Internet. This water level data can be used 

for various purposes for better management of water sources. The ultrasonic sensor detects the 

surface of the water. Data from the ultrasonic sensor send to nodeMCU. The process of this 

system shows on the LCD. The way this monitoring work is by using an ultrasonic sensor to 

detect the surface. The data from the ultrasonic sensor will be processed by a microcontroller 

in the form of an Arduino. Processed by Arduino and transferred data in relay module. IoT-

based smart pump control and water level monitoring system will be helpful to collect, analyze, 

and predict the water level detail, water usage, and other information of a particular water 

source at a particular location in real-time remotely. It also signifies when the water level is 

below and above then the requirement. System design and architecture are discussed, thus 

being a cost-effective and simple strategy to monitor the water level system. 
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CHAPTER  6 

CONCLUSIONS AND RECOMMENDATIONS 

 

6.1 CONCLUSIONS 

 The smart water level indicator is a cutting-edge sort of display. The key benefit of this 

technology is that it can accurately calculate the percentage of water in the feed water 

tank and reservoir tank.  

 The adoption of a smart water level indicator system helps to develop the fourth 

industrial revolution. Compared to the manual system, this system offers the advantage 

to monitor via a mobile app.  

 The authority of the industry is always alert for supplying water in the boiler. Now, this 

data will be saved on the mobile via IoT by using the nodeMCU, ultrasonic sensor, 

database, and mobile app. 

 The percentage of water was shown in a display so that operator can determine the 

condition of the water level in the tank.  

 Finally, the Experiment Analysis of Boiler Feed Water Level Indication and Pump 

Monitoring Using IoT (Internet of Things) has implemented of water level indication 

and monitoring system. This project can develop with the help of our supervisor. 

 

6.2 RECOMMENDATIONS  

 We will implement a float sensor in the tank. The accuracy of this sensor is more than 

ultrasonic sensor.  

 PH sensor will also attach in the future. So that properties of water will also know.  

 Program logical control (PLC) will implement here to operate the high-pressure pump 

or high amp pump. 

 

6.3 SUGGESTION FOR FURTHER STUDY 

Future Work can involve the analysis of water level in a particular area so that the wastage of 

water is prevented. We can also include the GSM-based system where the message will be sent 

to the particular authorized person when the water level is below the required level. Arduino 

GPS shield can be integrated into the system to obtain location data of the water source 

dynamically. 
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